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1.1 Introduction 
MREL’s DAS™ Data Acquisition Suite for MicroTrap +™ has been designed to be utilized with MicroTrap +™ VOD recorder. This software 
suite will allow the user to program (where applicable), download and analyze the data from the recorder. The DAS™ Data Acquisition 
Suite for MicroTrap +™ will allow the user to manage all of the files downloaded from MREL VOD/Data recorders using a single software.

This edition will allow the user to open data files from any of the the MicroTrap +™ VOD Recorder. The user can perform all of the 
standard features that the users have been accustom to. For a VOD channel, the measurements that a user can do are as follows:

•	 Measure Velocity of Detonation
•	 Borehole or Sample
•	 Measure Column Height
•	 Measure Booster Location
•	 Measure Time Delay Between Holes
•	 Measure Effectiveness of Decking
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2.1 System Requirements 
The minimum system requirements for DAS™ Data Acquisition Suite for MicroTrap +™ are as follows:  

•	 64-bit CPU: AMD/Intel
•	 Memory: 2 GB 
•	 Hard disk space: 1 GB, more space is required for large number of files.
•	 Ports: USB port (internal or powered)
•	 Monitor resolution: 1200 x 800
•	 Operating system: Windows 10 or later
•	 Full .NET 4 framework 

Administrative type of user account and Internet connection required for registration, upgrades, updates and support.  The software can 
be used offline when not performing any of the previous tasks.

2.2 Recommended System Requirements
The recommended system requirements for DAS™ Data Acquisition Suite for MicroTrap +™ are as follows:  

•	 64-bit CPU: AMD/Intel 
•	 Memory: 8 GB or more 
•	 Hard disk space: 25 GB or more
•	 Ports: USB 2.0 or 3.0 port (internal or powered)
•	 Monitor resolution: 1200 x 800 or more
•	 Operating system: Windows 10 or above (64-bit)
•	 Any suitable mail client program such as Microsoft Outlook, Mozilla Thunderbird etc. 
•	 Full .NET 4.5 or above framework
•	 Administrative type of user account and Internet connection required for registration, upgrades, updates and support. The software 

can be used offline when not performing any of the previous tasks.

2.3	 Prerequisites Installation Process
The DAS™ Data Acquisition Suite for MicroTrap +™ setup will display a message if necessary prerequisites from internet are needed to 
be installed first. It will direct user to the correct download page if computer is connected to the internet. If not connected, it will show the 
error page in the computer’s default web browser.

This section will step the user through the installation procedure on their computer.

Overview
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2.3.1 .NET Framework 4.0 Installation Process (if required)

Double click on the DAS™ Data Acquisition Suite for MicroTrap +™ 
install package (.msi) file or Right-Click on the file and choose install. 
You need to be using administrative type of user account on the 
computer to perform the installation.

If setup program has detected that the .NET Framework 4.0 is not 
installed, it will show the message as shown on the right.

If the computer is connected to the internet and user chooses Yes in 
above dialog, the default web browser is opened showing the .NET 
Framework 4.0 Full package download page.

Click the Download button to download .NET Framework 4.0 setup. 

The optional components suggested by the page can be ignored by 
clicking No thanks and continue button as shown to the right.

http://www.mrel.com
mailto:contact@mrel.com


DAS™ Data Acquisiton Suite Operations Manual - Edition 1.3

6

for MICROTRAP +™

Click the blocked pop-up tool-bar (if pop-up is blocked by browser) 
and select Download File... option as shown to the right.

Save the file in a desired temporary location as shown to the right.

Double click the downloaded file (.exe file) to install .NET 
Framework 4.0 shown to the right.
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Click the Yes button in UAC “User Account Control” dialog shown 
to the right.

The package will uncompress and shows the initial Microsoft .NET 
Framework 4 license Agreement dialog. Check Accept check box 
and click Install button as shown to the right.

When Installation finishes with success, you can proceed to run the 
installation package for DAS™ Data Acquisition Suite for  
MicroTrap +™ as described in the following section.

2.4 Installation Process

The installation package can be obtained at http://www.mrel.com/das 
and locally save it if you have either not received copy or have misplaced it. 

2.4.1	 Installation Process for Windows 7® 		
	 and Higher

 
Double click on the DAS™ Data Acquisition Suite for MicroTrap +™ 
setup package (.msi) or Right-Click on the file and choose install. 
You need to be using an administrative type of account on the 
computer to perform the installation. The installation dialog will 
appear with License Agreement as shown to the right.

I M P O R TA N T
MREL recommends exiting all programs before 

starting installation.

http://www.mrel.com
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Click I Agree and click on Next. This will display the image to the 
right. 

Click the Next button to confirm the installation process to begin. 
This will results in the following screen.

Click the Next button which results in the following User Account 
Control (UAC) dialog for Windows 7® or above.

Click YES to proceed.
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In Windows 7®, the User Account Control (UAC) dialog may look 
like the image shown to the right. Click Allow to proceed

 

Installation process will begin and the image to the right will be 
shown.

Click the YES button to install the needed drivers.

http://www.mrel.com
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Click OK to the following message box which shows the drivers installation 
was successful. Click Close to complete the installation.

Click Yes to restart the system to complete the installation (this is 
recommended) in the image shown right.

System will restart to complete the installation.

If you clicked No so as not to restart the system, click Close to complete the 
installation.

The DAS™ Data Acquisition Suite for MicroTrap +™ has been successfully 
installed. 

A program group MREL with the folder DAS™ will be created in 
Start > All Programs menu. Also a shortcut named DAS™ Data 
Acquisition Suite for MicroTrap +™ is created on the desktop as 
show to the right.



T: +1-613-545-0466   www.mrel.com  contact@mrel.com

11

2.5	Uninstallation of DAS™ Data Acquisition Suite for 
MicroTrap +™

2.5.1 Uninstallation Process

Uninstalling DAS™ Data Acquisition Suite for MicroTrap +™ on 
supported version of Windows® Operating Systems is similar. 

To uninstall DAS™ Data Acquisition Suite for MicroTrap +™, click 
Control Panel panel in Start. The control panel is displayed as 
follows.

Click Programs and Feature icon in Control Panel which displays a 
screen shown as to the right.

Select MREL Data Acquisition Suite in the list and Double-Click it. 
This shows the image on the right.

I M P O R TA N T
To uninstall the software, you need to use an administrative type of user account on the computer.

http://www.mrel.com
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Click Yes button to the dialog asking Are you sure you want to 
uninstall MREL Data Acquisition Suite? which shows the Preparing 
to remove status dialog.

Click Yes button in UAC (User Account Control) dialog as shown to 
the right.

In Windows Vista®, the UAC dialog box will look like the image 
shown to the right. Click Allow to proceed

Uninstall will show a progress dialog box similar to the image to 
the right.

Once the progress dialog box completes, the DAS™ Data 
Acquisition Suite for MicroTrap +™ will be successfully uninstalled. 
However, your data and related settings will still be present. 

You can now close Programs and Features dialog and the Control 
Panel itself.
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This Chapter describes the starting process for the DAS™ Data Acquisition Suite for MicroTrap +™.

3.1 Starting the DAS™ Data Acquisition Suite for MicroTrap +™
Double click on the DAS™ Data Acquisition Suite for MicroTrap +™ 
desktop icon. 

Alternatively access the program through the Start Menu. 
Start > All Programs > MREL > DAS > DAS™ Data Acquisition Suite 
for MicroTrap +™.

The following splash screen will show up.

When DAS™ Data Acquisition Suite for MicroTrap +™ completes 
loading, the splash screen fades away to show the main screen as 
shown to the right.

After the initial screen is displayed, the DAS™ Data Acquisition 
Suite for MicroTrap +™ may check and update the main display for 
any connected MREL Data or VOD recorders and any tests stored 
if any.

Note: 	 The message box to the right is displayed for a short period of time  
		  upon starting the software. The software is checking for any hardware  
		  attached to the computer. The software periodically checks for any  
		  changes in connected status of the recorders.

Overview
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4.1	 Programming the MicroTrap +™ VOD Recorder
The MicroTrap +™ VOD Recorder has the ability to record the velocity of detonation (VOD) as the sttwo channels. In order to program the 
MicroTrap +™ VOD Recorder, the USB interface cable has been connected to the computer. The cable is then connected to the MicroTrap 
+™ VOD Recorder after 10 seconds, the unit is powered on. If unsure how to complete this task, refer to the MicroTrap +™ VOD Recorder 
Operations Manual.

4.1.1	 VOD Setup in the MicroTrap +™ VOD Recorder

With the MicroTrap +™ VOD Recorder connected to the computer, 
start the DAS™ Data Acquisition Suite for MicroTrap +™. Upon fully 
starting, the screen will appear as shown to the right.

Click on the Hardware tab on the left panel of the screen (As 
marked in the right image) and the image on the next page will be 
displayed.

Click on the Standard Setup radio button under Choose Device and the Setup radio button under Hardware. Then click on the Next 
button.

This Chapter describes the programming procedures for all of the Recorders.

Overview
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This screen will display many details of the individual unit. This 
includes the serial number and calibration due date.

On this screen, the user will be able to adjust all of the VOD 
settings on the MicroTrap +™ VOD Recorder. The options will be 
ProbeCable, ProbeRod and Detonator Timing.  These are standard 
setups for the desired testing.  If you are looking for more control 
on the settings, please use the Advanded Setup.  Within this menu, 
the following items can be adjusted.  This includes the VOD Trigger 
Level, Trigger Type. Refer to the MicroTrap +™ VOD Recorder 
Operations Manual for definitions on these settings. Once the 
settings have been selected, click on Store Settings button. 

Auto Advance will allow the unit to continue to trigger when a valid 
trigger is received.  This will assist with false triggering as it will 
continue to trigger until the STOP  Button is pressed.  This will setup 
tests within a session.  To assist in selecting the correct test, note the 
time of the blast as the real time clock will display the time of the 
recording.

Delay Mode is not available in the Standard setup.  To use this 
mode, please select Advanced Setup.

4.1.2 Advanced Setup 
With the MicroTrap +™ VOD Recorder connected to the computer, 
start the DAS™ Data Acquisition Suite for MicroTrap +™. 

Upon fully starting, the screen will appear as shown to the right.

Click on the Hardware tab on the left panel of the screen (As 
marked in the right image) and the image on the next page will be 
displayed. Select the Advanced Setup radio button.  Then click on 
the Next button.

http://www.mrel.com
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On this screen, the user will be able to adjust all of the VOD settings 
on the MicroTrap +™ VOD Recorder. The options will be Advanced 
Settings as the other options are grayed out. Within this menu, the 
following items can be adjusted.  This includes the Sample Speed 
(2, 1 MHz, 500, 100 kHz), Test Time, Pre-Trigger Time, VOD 
Trigger Level, and Trigger Type. Refer to the MicroTrap +™ VOD 
Recorder Operations Manual for definitions on these settings. Once 
the settings have been selected, click on Store Settings button. 

Auto Advance will allow the unit to continue to trigger when a valid 
trigger is received.  This will assist with false triggering as it will 
continue to trigger until the STOP Button is pressed.  This will setup 
tests within a session.  To assist in selecting the correct test, note the 
time of the blast as the real time clock will display the time of the 
recording.

Delay Mode will delay the powering up of the unit to allow for the conservation of the battery.  If this mode is selected, an option from 1 
to 23 hours is available.  When the value is selected and the unit is properly connected in the field, when the START Button is pressed, the 
unit will power off.  It will turn on after the selected number of hours and then will wait for a valid trigger.  

This is useful when the equipment needs to be left in place for a long time before the event.

4.1.3 Delete All Tests
When this option is selected from the Hardware tab, click the Next button.  A popup will ask if you wish to delete all of the tests.  If you 
do, click Yes.  If not, click No.
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5.1	 Downloading from the MicroTrap +™ VOD Recorder
This section will detail the download procedure for the MicroTrap 
+™ VOD Recorder. With the unit connected to the computer and 
the hardware tab selected, the follow screen will be displayed.

With the radio buttons selected of MicroTrap +™ VOD Recorder in 
the Choose Device section and Download selected in the Hardware 
section. There are two types of downloads that can occur with the 
MicroTrap +™ VOD Recorder. When there are more than one test 
stored in the memory of the unit, both radio buttons are available, 
Download All Tests and Download Selected Tests. This manual will 
step through both options.

This screen is displaying the directory structure, the file name of the 
file, the selected resistance of the VOD Sensor (as shown on the 
package) as well as the active channels.

With the MicroTrap +™ VOD Recorder, the unit will record a 
session for each time that the START Button has been pressed.  If 
using the Auto Advance setting during setup, a test will be created 
for each valid trigger that is received inside of the session.  

If Auto Advance is not selected, the MicroTrap +™ VOD Recorder 
will have one test within each session.

When all of the information has been entered into the text box  
(this information will always be available with this file) and 
navigated to the desired location, click download.

If an error occurs during the download of the file, the following 
message will be displayed.  I will have a popup box with the error 
message as well as Error displayed beside the Download Button.

To proceed, click OK and try and download again.  If the error 
persists, please restart the program.

This section describes how the data is retrieved from the recorders. Here the procedure is 
described for each type of recorder. 

Overview
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This is the screen that the user will view showing the directory/file 
structure of the computer. The user will need to select a directory 
on the hard drive where the data is to be saved. With the directory 
selected, an appropriate file name for the group of tests that are to 
be downloaded needs to be entered in the File Name text box. The 
default file name provided can be used as well.

When the Download button is clicked, the following progress bar is displayed.

Note: 	 For VOD channels, the correct Probe MUST be selected. This cannot be changed later. 

When the Download button is clicked, the following progress bar is displayed.

When the download has been completed, click OK to display the Accept screen as shown.

http://www.mrel.com
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6.1 Selecting a Data File

From the main screen, select the Open Data File tab. The following 
screen will be displayed.

By default, all recorder data file types are selected (DT2-DataTrap 
II™ Data/VOD Recorder, HT2-HandiTrap II™ VOD Recorder, MT-
MicroTrap +™ VOD Recorder). The user can select only the one type 
of file if desired. Once the desired file type is selected to be visible 
in the next screen, there are four (4) different ways to search for a 
file. They are Browse, Recently Opened Files, Recently Downloaded 
and Calendar.

6.2	 Calendar
This section is used to open a file if the download date is known. 

With the Calendar radio button selected and selecting Next, the 
following window will be displayed.

This option will display a calendar for the user to select the date 
that the file was downloaded. A blue box is placed around the 
current date and the date that is in bold font has a file associated 
with that date. In this example, June 18, 2025 has data files associated with the date. In the box below is the file location of the data 
with the file name. All of the files downloaded on the selected date will show in the bottom window. The user will select the file from the 
bottom box and click Open. The file will open in the Analyze tab. If no files are to be opened, click Cancel. 

This section describes how to open a previously saved data file downloaded from either a 
HandiTrap II™ VOD Recorder, MicroTrap +™ VOD Recorder or DataTrap II™ Data/VOD Recorder. 

Overview
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6.3	 Browse

The Browse feature is the typical way to use the file browser to find 
a file. By clicking the Browse radio button and selecting Next, the 
following screen will be displayed.

This screen will allow the user to navigate through the directory/
file structure of the computer to find the desired file. From the 
previous page, only the selected file types will be displayed. The 
user can click on Go To Home to return to the default directory 
defined in the software. When the desired file is located, select the 
file by left clicking on the file name once and then clicking Open. 
To stop the process, click Cancel. When Open has been clicked, 
the file will start to load. After file is loaded, the main window will 
return with the Analyze tab opened. To analyze the data, refer to 
the Analyze section.

6.4	 Recently Opened Files
This section is used to open a file that has been opened recently. 
The computer will record the files that have been opened and will 
produce a list of files for the user.

The user will select Recently Opened Files radio button from the 
Open Data File tab and select Next and the following window will 
appear.

The DAS™ Data Acquisition Suite for MicroTrap +™ will display 
eight (8) previously opened files. This includes all of the file types 
selected in the File Type window in the previous section. The user 
will just click on the blue link and the file will open and the file will 
show up in the Analyze tab. If no files wish to be opened from the 
list, the user can click Close.
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6.5	 Recently Downloaded Files
This option will open a list of the most recent downloaded files from 
the recorders.

With the Recently Downloaded radio button selected and selecting 
Next, the following window will be displayed.

The DAS™ Data Acquisition Suite for MicroTrap +™ will display 
eight (8) previously downloaded files. This includes all of the file 
types selected in the File Type window in the previous section. The 
user will just click on the blue link and the file will open and the file 
will show up in the Analyze tab. If no files wish to be opened from 
the list, the user can click Close.

If there is a zip button present next to a file entry, clicking 
it will create a zip file of original data on your desktop. 
That is useful if you want to send data to MREL  
(see Section 10.2)

6.6	 Working With the  
		  Data File
The image to the right shows a data file MP2025Nov061_s01_t001.
mtpt open. IIt shows Channel 1 is ON while Channel 2 is OFF. 
The meaning of the lock is that the data cannot be modified on 
permanent basis or saved though it allows you to work with it. A 
user should always create a saved graph to work on. A saved 
graph needs to be created for VOD calculations. To create savable 
graphs, the user can Right-Click on the locked graph and save it as 
a different graph (a default name is suggested). The saved graph 
can also be deleted in this manner.

An Active Plot is normally required to do most operations such as exporting data, change plot line 
or point colour, creating point cursors, creating annotations, creating VOD or Delta calculations. For 
making a plot active, check mark a plot entry in Active Plot Selector Grid on the lower left of Analysis 
tab. Only one plot in a graph can be active at a given time.

6.7	 Closing a Data File
To close a data file, Right-Click on the file name in the Graph Tree and select Close. The software will ask for a confirmation, click Yes to 
close the file or No to cancel and return to the file. The user can also use Close All in top File menu which closes all opened files.
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This section will detail the analysis of the data collected from the recorders. It will show how the software will work and not the correct or 
incorrect way to analyze certain types of data. Below is the view of the software with a data file open. Across the top of the screen is a 
ribbon menu with five (5) different tabs.

This section will detail the analysis of the data collected from the MicroTrap +™ VOD Recorder.

Overview
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7.1 	Home Tab 

In the Home tab most functions are of general nature that are used in graphing, saving and zooming. It includes the following functions:

•	 Zoom In – Allows the user to zoom in on the graph to an area of interest. 
The feature works by clicking on Zoom In and selecting a box around the area of interest by dragging a mouse with left mouse 
button pressed in.  

•	 Zoom Out – Allows the user to zoom out.  
Click on Zoom Out as many times it is required or until the full view has been reached. 

•	 Full – Allows a single button click to zoom out to the maximum range of the graph. Click on once for maximum zoomed out area. 

•	 Original – Allows a one button click to zoom out to the maximum range of the saved graph. 
Click on once for the saved graph to return to its original saved range.  

•	 Pan – Allows for the scrolling of the graph. 
The pan button is a toggle ON or OFF. When it is on, the mouse can be used to click in and drag the graph. 

•	 Save As – Allows a graph to be saved as a new graph with the current zoomed range.  
With the current viewable area as desired range, click on Save As and a text box will pop up to allow a name to be entered  
by the user. 

•	 Delete – Allows the Saved As graphs to be deleted. Will not delete the original graphs. 
With a saved graph selected, the user can click this button and a conformation box will appear to confirm the deletion of the graph. 

•	 Copy - Copies the current graph to the clipboard as a bitmap image.  User then can paste this image in another suitable word 
processing software such as MS Word, WordPad etc. 

•	 File - Save the current graph image to a file as a JPG, MBP or PNG file. 

•	 Point Cursor – Creates a movable vertical point cursor which shows the X, Y coordinate of current data point on the graph. 
Click on the button and follow the on screen directions. The Point Cursor can be moved with the mouse or the left and right arrow 
keys.  To select an individual point, the user may need to zoom in closer to select the desired point. The user can have multiple Point 
Cursors on the screen.  To remove, Right-Click on the Point Cursor and select Delete. Also with the Right-Click on the Point Cursor and 
selecting Modify, the user can adjust all of the individual properties on the Point Cursor.  
The Show/Hide Point Cursor will allow the user to copy the individual coordinates pointed by point cursors to the clipboard  to be 
pasted into a different application.  

•	 Show/Hide - Will allow the user to copy the individual coordinates pointed by the point cursors in the graph to the clipboard so 
as to be pasted into a different application. Click on the button. It can also be found in the Right-Click context menu of the individual 
Point Cursor or graph.
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•	 Annotation – Will allow user to enter text onto the graph. Follow the instructions on screen. 
Click on the button and then click on the screen. Right-Click on the Annotation and select Modify to modify the text, colour or font. 
From the Right-Click menu, the user can also delete the Annotation. 

•	 Arrow – Will allow the user to draw an Arrow with a caption. 
The user will draw an arrow with a textual caption attached to the end of the line. The user can change the text in the box by right-
clicking and selecting Modify. The shape at the arrow end of the line can be removed by in the same Modify box, scroll down to 
ShapeStyle and select none. The arrow tip can not be moved without a ShapeStyle present.  

•	 Line – Will allow the user to draw a Line. 
The user will click on the Line button and follow the on screen instructions. The line can be extended or moved. User can modify its 
font or thickness using its Modify context menu. 

•	 Image – Will allow the user to insert a picture. 
The user will click on Image and follow the on screen directions. A directory/file structure window will pop up of the local computer. 
The user can navigate the computer and select the image of interest. The user will need to select top-left corner of the image to drag 
it to the area of interest and will be able to Right-Click on the corner to select Modify and adjust the displayed size. The Modify 
dialog box also allows user to select a different image using “Change…” button. 

•	 Cut – Will allow the selected annotation to be cut. The selected annotation has a red rectangle around it when user Left-Click it 
once. 
The user will need to select an item and then select Cut. If no item or a non-valid item is selected, the Cut button will not be available. 
The item will be placed on the computer’s clipboard. 

•	 Copy – Will allow the selected annotation to be copied. 
The user will need to select an annotation and then select Copy. If no annotation or a non-valid item is selected, the Copy button will 
not be available. The annotation will be placed on the computer’s clipboard. 

•	 Paste – Will allow the last copied or cut annotation to be pasted. 
This button will allow the user to Paste the item in the same graph that has been placed on the computer’s clipboard.  Note that 
annotation can be pasted to different graph nodes of the same or different data file (in version later than 1.0.0.0). VOD and Delta 
values cannot be copied or pasted. 

7.2	 View Tab

In the View tab are features that effect how the data is displayed.

•	 Linear – Displays the X and Y axes with a linear scale. 
The user can click on the Linear check box to change the axes to Logarithmic 

•	 Logarithmic – Displays the X and Y axes with a logarithmic scale. 
The user can click on the Logarithmic check box to change the axes to Linear
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•	 Axes Range – Displays the following text box for the user to manually enter the 

axes range 
The user can enter specific ranges into the menu without the requirement to zoom. 
Enter the desired values and click Apply or if no changes are desired, click Close. 
 
 
 

•	 Axes Title – Allows the user to modify the axes titles or graph caption. 
The user can modify the titles by entering the desired information in the text box and 
clicking Apply. If no changes are desired, click Cancel.  
 
From the main graph window, CTRL Key + Left-Click on the X-axis, Y-axis or graph 
caption bar to display individual title change dialog. 
 

•	 Plotting Styles – Allows the user to change the way a plot is drawn.  
The default is Line connecting the data points with a line. Point will only display the data 
points while Point + Line will display both. Only the Active plot is affected. 
 
 

•	 Line Thickness – Allows the user to change the line thickness of the active plot. 
The user can either click and drag the slider bar or use the + and – buttons to change the thickness 
of the drawn line. 

•	 Point Colour – Allows the user to change colour of the data points of active plot. 
The Point Colour button will change the colour of the data points of active plot while the pull down 
arrow will allow the user to select the colour from a pallet of colours. 
 
 
 
 
 
 
 

•	 Line Colour – Will allow the user to change the line colour of the active plot.  
The Line Colour button will change the line colour of the active plot while the pull down arrow will 
allow the user to select the colour from a pallet of colours. 
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•	 Graph Tree – Allows the user to show and hide the graph 
tree view on the left side of the screen. It will allow the graph 
area to extend from the right image all the way to left edge of 
main window: 
 
 
 
 
 
 
 
 
 
 
 
 
To the image to the right: 
 
A single click on the Graph Tree button will change back and 
forth between the two screens. 
 
 
 
 
 
 
 
 
 
 
 

•	 Grid Lines Major – By selecting the check box will display the major grid lines.  
It can be turned on and off by the check box. 

•	 Grid Lines Minor – By selecting the check box will display the minor grid lines.  
 It can be turned on and off by the check box.
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7.3	 VOD Tab

•	 Start/Done – Allows the start of the VOD measurement. The button will change to Done after the process has been started. 
Follow the on-screen directions and click and drag the vertical point cursors to the desired location. See the Quick Start Guide for the 
use of the button.  Clicking Done will finish the VOD measurement process. 

•	 Cancel – Allows the VOD measurement to be canceled. 

•	 Linear Regression – Allows the user to use Simple Linear Regression to produce a line of best fit of the points between the two 
end points. 
The definition of Simple Linear Regression is a fit of a straight line through the set of n points in such a way that makes the sum of 
squared residuals of the model (that is, vertical distances between the points of the data set and the fitted line) as small as possible. 

•	 2-Point – Allows the user to measure VOD with using only the start and end point. 
The VOD is calculated by the following equation: (y2-y1)/(x2-x1), where (x1,y1) is the first point and (x2,y2) is the second point. This 
is used when the data is ‘noisy’ and the points in the middle need to be ignored. As long as the line matches the straight edge of the 
data, then the value obtained from the calculation is valid. 

•	 Data Section 
In this area, values being calculated are displayed when a VOD measurement has started and being calculated dynamically. 
The VOD value will be displayed and will change if the user selects Linear Regression or 2-Point method. The values will change 
accordingly as user moves vertical data cursors by mouse or left (right) keys. The user can finish VOD calculation process either by 
clicking Done button in the VOD tab or in “Choose points for VOD/Delta calculation” dialog. (See more details in Analysis section or 
in built-in help.)

 
7.3.1 How to measure VOD 

See VOD Analysis Section 7.6.
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7.4	 2-Point Functions Tab

•	 Start/Done – Allows the user to measure the amount of time (delta X) and the amount of Y-axis units (meter or feet)  
(delta Y) between the two selected points. 
The user will select start and will follow the on-screen instruction.  
 
 
 
 
 
The screen to the right shows the two vertical point cursors and 
the two (X,Y) points.In the ribbon menu in the Data section, the 
values of the two points and the difference is also displayed.  
 
 
 
 
 
 
 
 
 
 
 
 
When Done is clicked, the calculated values are shown on the 
graph as in the second screen. 
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•	 Cancel – The Cancel button is to stop the 2-Point Function operation. 

•	 Delta X (x-axis units of graph such as ms, s) – This check box defines if the delta value for quantity X (usually time) is to be 
calculated and displayed. If the box is unchecked, the delta value will disappear in the Data section. Also, if the box is unchecked, 
the value will not be calculated or displayed when Done is selected. 

•	 Delta Y (y-axis units of graph such as m, V or engineering units) – This check box defines if the delta value for quantity Y (such as 
distance, voltage etc.) is to be calculated and displayed. If the box is unchecked, the delta value will disappear in the Data section. 
Also, if the box is unchecked, the value will not be displayed during the calculation process or after when Done button is clicked.

7.5	 Help Tab
This section describes the Help tab. 

•	 About – Opens the window showing the version number of the 
software and the contact details for MREL Group of Companies Limited 
including website, email, address and phone and fax numbers. 

•	 Keyboard Shortcuts – Displays the keyboard shortcuts. To the 
right is the screen

7.6 VOD Analysis
Analysis of VOD is the measurement of the velocity of detonation  
of explosives. The instruments capable of this measurement is: 
HandiTrap II™ VOD Recorder, MicroTrap +™ VOD Recorder and 
DataTrap II™ Data/VOD Recorder with VOD Upgrade. With the 
graph opened, the screen to the right is displayed. 

In this example, the file name is Borehole_Ex.ht2 which is a 
HandiTrap II™ VOD Recorder file. On the left side of the screen, 
the column displays all of the important information regarding the 
file. This example shows that there is 1 active VOD channel (shown 
with a green circle with a white check mark). 

The user will need to decide which type of VOD measurement that 
is desired: Linear Regression or 2-Point.  
 
Please refer to the descriptions below to which type of VOD 
measurement is desired.  
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With the desired check box selected and the graph zoomed into the relevant 
area, click Start. The following screen will be displayed. 

Click OK to continue. 
 
The user will see two vertical point cursors. The selected data points are 
displayed (X,Y) where the  point cursors intersect the data. The user can click 
and drag the point cursors to the the desired locations. The VOD 
Feedback Line shown in green here, is a visual aid to user so a 
better close match to actual data  can be achieved. If you do not 
have this, please update DAS™ to latest version 
 (See Section 2.8).  

Reconfirm that the desired method has been selected and the Data 
section will display a quick reference to the two points and the 
VOD prior to pressing Done.  
 
Once Done has been pressed and the VOD line is displayed, this is 
the only time that the user can compare the VOD line to the data. 

If the VOD line does not match the data, it is not a valid VOD 
measurement.

As shown in the graph to the right, the selected line is not the 
best fit for the data. The user can place as many different VOD 
measurements as desired.

The line is shown above the data at the beginning, below in the 
middle and above the measurement at the end. The image to the 
right is a better measurement.

From the screen to the right, the two VOD lines have been closely 
fit to the data where each line fits the data in the section of 
measurement. This shows a change in velocity from the bottom of 
the hole to the top.
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7.7 Exporting Graph 
7.7.1 Export Graph Data

Right-Click a graph which displays following context menu. 
 
Choose Export to export active plot original data range to a CSV file. Or choose Export Visible to export active plot data using current 
visible range of graph to a 2-column CSV file.

7.7.2 Export Graph Image 

Right-Click a graph which displays following context menu. 
 
Choose Save As Image which displays a Save as dialog with directory structure displayed on the computer. The user can save the graph 
image as Jpeg, Bitmap, Gif and PNG files.

 
7.8 User Preferences 
The user can change various preference applicable (some available in version beyond 
1.0.0.0) to many aspects of the software operation. These includes Auto Save, Default 
Language (English (default) or French), Ribbon menu Style, Default font, Active plot 
legend ON/OFF, Export Time units type (seconds or default), Apply Offset type and 
Visual Feedback line colour for VOD. These preferences are controlled through the 
following dialog using menu item File > Preferences. See built-in help for details. 
 
 

 

http://www.mrel.com
mailto:contact@mrel.com


DAS™ Data Acquisiton Suite Operations Manual - Edition 1.3

38

for MICROTRAP +™



T: +1-613-545-0466   www.mrel.com  contact@mrel.com

39

Chapter 8
Contacting MREL for

Technical Support

https://www.mrel.com
mailto:contact%40mrel.com?subject=


DAS™ Data Acquisiton Suite Operations Manual - Edition 1.3

40

for MICROTRAP +™

8.1 Contacting MREL

8.2 Emailing Data Files to MREL
For DAS™ Data Acquisition Suite for MicroTrap +™ software, the user with need to send the following files for analysis of the user’s data. In 
this example, the users file name is Myfile.
 
8.2.1 MicroTrap +™ VOD Recorder 

The following files will be needed: 

•	 Myfile.mtpr
•	 Myfile.mtpt
•	 Any related files with the same name such as Myfile.xml and Myfile.zip if applicable 

MREL Group of Companies Limited

Data Acquisition Team (DAS™) Support Team

5-779 Sir John A MacDonald Blvd. 
Kingston, Ontario K7L 1H3
Canada

Toll Free	 +1-877-544-MREL (Canada/USA)
Tel: 		  +1-613-545-0466

Email: 	 das@mrel.com

Support:	 www.mrel.com/contact-us

MREL looks forward to providing you with assistance.
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